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e² studio 6.3.0 
Release Note 
Introduction 
This document outlines the device support, new features added in 6.3.0, fixed issues and open issues in e² studio 6.3.0. 
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1. Product Information
1.1 Supported Operating Systems 

These operating systems are officially supported by e2 studio: 

• Windows 7 32-bit

• Windows 7 64-bit

• Windows 8.1 32-bit

• Windows 8.1 64-bit

• Windows 10 32-bit

• Windows 10 64-bit

1.2 Supported Toolchains 
The following toolchains are supported in e² studio 6.3.0. 

Renesas GNU Arm  
Embedded (*2) 

Renesas GCC/  
GNURZ/ARM (*3) 

IAR (*4) Green Hills 
(*5) 

D
ev

ic
e 

Fa
m

ily
 

RL78 Yes (CC-RL) No Yes Yes No 

RX Yes (CC-RX) No Yes Yes No 

RH850 No No No Yes Yes 

RZ/ARM No No (*1) Yes Yes No 

Synergy/ARM No Yes No Yes No 

Note: 
*1: Project converter is now available to convert from GNUARM RZ/none to GNU ARM Embedded toolchain.

*2: The GCC toolchains for RZ Family and Renesas Synergy™ are distributed via
Arm Developer at https://developer.arm.com/open-source/gnu-toolchain/gnu-rm 
or Launchpad.net at: https://launchpad.net/gcc-arm-embedded.  

*3: Legacy GNUARM toolchains are now available from https://gcc-renesas.com/. In addition, the latest
RX and RL Renesas GCC toolchains are available from this website. 

*4: The IAR toolchain plugins are available via the “Help”->”IAR Embedded Workbench plugin manager”
menu in e2 studio. These Eclipse plugins are provided by IAR and are not supported by Renesas. 

*5: The Green Hills toolchain plugins are available within the e² studio product. These plugins are provided
by Green Hills and are not supported by Renesas. 

https://developer.arm.com/open-source/gnu-toolchain/gnu-rm
https://launchpad.net/gcc-arm-embedded
https://gcc-renesas.com/
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2. Device Support 
2.1 Project Generator Support 
Note: The Renesas SH device family is no longer supported in e2 studio. 

CPU Family Devices 
EC-1 EC-1 R9A06G043 

RH850 

C1H R7F701260, R7F701270,(Debug Support Only) 
C1M R7F701263, R7F701271,(Debug Support Only) 
E1L R7F701201, R7F701205,(Debug Support Only) 
E1M-S R7F701202, R7F701204,(Debug Support Only) 

- R7F701Z05, R7F701Z06, R7F701Z07,(Debug Support Only) 

F1H 
R7F701501, R7F701502, R7F701503, R7F701506, R7F701507, 
R7F701508, R7F701511, R7F701512, R7F701513,(Debug Support Only) 

F1H-
GW R7F701521, R7F701522, R7F701524, R7F701525,(Debug Support Only) 

F1K 

R7F701542, R7F701543, R7F701546, R7F701547, R7F701557, 
R7F701560, R7F701561, R7F701562, R7F701563, R7F701566, 
R7F701567, R7F701577, R7F701580, R7F701581, R7F701582, 
R7F701583, R7F701586, R7F701587, R7F701597, R7F701602, 
R7F701603, R7F701610, R7F701611, R7F701612, R7F701613, 
R7F701620, R7F701621, R7F701622, R7F701623,(Debug Support Only) 

F1L 

R7F701002xAFP, R7F701003xAFP, R7F701006xAFP, R7F701007xAFP, 
R7F701008xAFP, R7F701009xAFP, R7F701010xAFP, R7F701011xAFP, 
R7F701012xAFP, R7F701013xAFP, R7F701014xAFP, R7F701015xAFP, 
R7F701016xAFP, R7F701017xAFP, R7F701018xAFP, R7F701019xAFP, 
R7F701020xAFP, R7F701021xAFP, R7F701022xAFP, R7F701023xAFP, 
R7F701024xAFP, R7F701025xAFP, R7F701026xAFP, R7F701027xAFP, 
R7F701028xAFP, R7F701029xAFP, R7F701030xAFP, R7F701032xAFP, 
R7F701033xAFP, R7F701034xAFP, R7F701040, R7F701041, R7F701042, 
R7F701043, R7F701044, R7F701045, R7F701046, R7F701047, 
R7F701048, R7F701049, R7F701050, R7F701051, R7F701052, 
R7F701053, R7F701054, R7F701055, R7F701056, R7F701057,(Debug 
Support Only) 

F1M 

R7F701544, R7F701545, R7F701548, R7F701549, R7F701552, 
R7F701553, R7F701564, R7F701565, R7F701568, R7F701569, 
R7F701572, R7F701573,(Debug Support Only) 

P1H-C 
R7F701370AEEBG, R7F701371EABG, R7F701372EABG, 
R7F701396EABG,(Debug Support Only) 

P1L-C R7F701388, R7F701389, R7F701390, R7F701391,(Debug Support Only) 

P1M 

R7F701304, R7F701305, R7F701310, R7F701311, R7F701312, 
R7F701313, R7F701314, R7F701315, R7F701318, R7F701319, 
R7F701320, R7F701321, R7F701322, R7F701323,(Debug Support Only) 
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P1M-C 
R7F701373xABG, R7F701374xAFP, R7F701397xABG,(Debug Support 
Only) 

 - 

R7F701060xAFP, R7F701062xAFP, R7F701064xAFP, R7F701065xAFP, 
R7F701067xAFP, R7F701069xAFP, R7F701071xAFP,(Debug Support 
Only) 

RL78 

D1A 

R5F10CGB, R5F10CGC, R5F10CGD, R5F10CLD, R5F10CMD, R5F10CME, 
R5F10DGC, R5F10DGD, R5F10DGE, R5F10DLD, R5F10DLE, R5F10DMD, 
R5F10DME, R5F10DMF, R5F10DMG, R5F10DMJ, R5F10DPE, R5F10DPF, 
R5F10DPG, R5F10DPJ, R5F10DPK, R5F10DPL, R5F10DSJ, R5F10DSK, 
R5F10DSL, R5F10TPJ 

F12 

R5F10968, R5F1096A, R5F1096B, R5F1096C, R5F1096D, R5F1096E, 
R5F109AA, R5F109AB, R5F109AC, R5F109AD, R5F109AE, R5F109BA, 
R5F109BB, R5F109BC, R5F109BD, R5F109BE, R5F109GA, R5F109GB, 
R5F109GC, R5F109GD, R5F109GE, R5F109LA, R5F109LB, R5F109LC, 
R5F109LD, R5F109LE 

F13 

R5F10A6A, R5F10A6C, R5F10A6D, R5F10A6E, R5F10AAA, R5F10AAC, 
R5F10AAD, R5F10AAE, R5F10ABA, R5F10ABC, R5F10ABD, R5F10ABE, 
R5F10AGA, R5F10AGC, R5F10AGD, R5F10AGE, R5F10AGF, R5F10AGG, 
R5F10ALC, R5F10ALD, R5F10ALE, R5F10ALF, R5F10ALG, R5F10AME, 
R5F10AMF, R5F10AMG, R5F10BAC, R5F10BAD, R5F10BAE, R5F10BAF, 
R5F10BAG, R5F10BBC, R5F10BBD, R5F10BBE, R5F10BBF, R5F10BBG, 
R5F10BGC, R5F10BGD, R5F10BGE, R5F10BGF, R5F10BGG, R5F10BLC, 
R5F10BLD, R5F10BLE, R5F10BLF, R5F10BLG, R5F10BME, R5F10BMF, 
R5F10BMG 

F14 

R5F10PAD, R5F10PAE, R5F10PBD, R5F10PBE, R5F10PGD, R5F10PGE, 
R5F10PGF, R5F10PGG, R5F10PGH, R5F10PGJ, R5F10PLE, R5F10PLF, 
R5F10PLG, R5F10PLH, R5F10PLJ, R5F10PME, R5F10PMF, R5F10PMG, 
R5F10PMH, R5F10PMJ, R5F10PPE, R5F10PPF, R5F10PPG, R5F10PPH, 
R5F10PPJ 

F15 

R5F113GK, R5F113GL, R5F113LK, R5F113LL, R5F113MK, R5F113ML, 
R5F113PG, R5F113PH, R5F113PJ, R5F113PK, R5F113PL, R5F113TG, 
R5F113TH, R5F113TJ, R5F113TK, R5F113TL 

F1A R5F114GC, R5F114GD, R5F114GE, R5F114GF, R5F114GG 
G10 R5F10Y14, R5F10Y16, R5F10Y17, R5F10Y44, R5F10Y46, R5F10Y47 
G11 R5F1051A, R5F1054A, R5F1056A, R5F1057A, R5F1058A 

G12 

R5F10266, R5F10267, R5F10268, R5F10269, R5F1026A, R5F10277, 
R5F10278, R5F10279, R5F1027A, R5F102A7, R5F102A8, R5F102A9, 
R5F102AA, R5F10366, R5F10367, R5F10368, R5F10369, R5F1036A, 
R5F10377, R5F10378, R5F10379, R5F1037A, R5F103A7, R5F103A8, 
R5F103A9, R5F103AA 
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G13 

R5F1006A, R5F1006C, R5F1006D, R5F1006E, R5F1007A, R5F1007C, 
R5F1007D, R5F1007E, R5F1008A, R5F1008C, R5F1008D, R5F1008E, 
R5F100AA, R5F100AC, R5F100AD, R5F100AE, R5F100AF, R5F100AG, 
R5F100BA, R5F100BC, R5F100BD, R5F100BE, R5F100BF, R5F100BG, 
R5F100CA, R5F100CC, R5F100CD, R5F100CE, R5F100CF, R5F100CG, 
R5F100EA, R5F100EC, R5F100ED, R5F100EE, R5F100EF, R5F100EG, 
R5F100EH, R5F100FA, R5F100FC, R5F100FD, R5F100FE, R5F100FF, 
R5F100FG, R5F100FH, R5F100FJ, R5F100FK, R5F100FL, R5F100GA, 
R5F100GC, R5F100GD, R5F100GE, R5F100GF, R5F100GG, R5F100GH, 
R5F100GJ, R5F100GK, R5F100GL, R5F100JC, R5F100JD, R5F100JE, 
R5F100JF, R5F100JG, R5F100JH, R5F100JJ, R5F100JK, R5F100JL, 
R5F100LC, R5F100LD, R5F100LE, R5F100LF, R5F100LG, R5F100LH, 
R5F100LJ, R5F100LK, R5F100LL, R5F100MF, R5F100MG, R5F100MH, 
R5F100MJ, R5F100MK, R5F100ML, R5F100PF, R5F100PG, R5F100PH, 
R5F100PJ, R5F100PK, R5F100PL, R5F100SH, R5F100SJ, R5F100SK, 
R5F100SL, R5F1016A, R5F1016C, R5F1016D, R5F1016E, R5F1017A, 
R5F1017C, R5F1017D, R5F1017E, R5F1018A, R5F1018C, R5F1018D, 
R5F1018E, R5F101AA, R5F101AC, R5F101AD, R5F101AE, R5F101AF, 
R5F101AG, R5F101BA, R5F101BC, R5F101BD, R5F101BE, R5F101BF, 
R5F101BG, R5F101CA, R5F101CC, R5F101CD, R5F101CE, R5F101CF, 
R5F101CG, R5F101EA, R5F101EC, R5F101ED, R5F101EE, R5F101EF, 
R5F101EG, R5F101EH, R5F101FA, R5F101FC, R5F101FD, R5F101FE, 
R5F101FF, R5F101FG, R5F101FH, R5F101FJ, R5F101FK, R5F101FL, 
R5F101GA, R5F101GC, R5F101GD, R5F101GE, R5F101GF, R5F101GG, 
R5F101GH, R5F101GJ, R5F101GK, R5F101GL, R5F101JC, R5F101JD, 
R5F101JE, R5F101JF, R5F101JG, R5F101JH, R5F101JJ, R5F101JK, 
R5F101JL, R5F101LC, R5F101LD, R5F101LE, R5F101LF, R5F101LG, 
R5F101LH, R5F101LJ, R5F101LK, R5F101LL, R5F101MF, R5F101MG, 
R5F101MH, R5F101MJ, R5F101MK, R5F101ML, R5F101PF, R5F101PG, 
R5F101PH, R5F101PJ, R5F101PK, R5F101PL, R5F101SH, R5F101SJ, 
R5F101SK, R5F101SL 

G14 

R5F104AA, R5F104AC, R5F104AD, R5F104AE, R5F104AF, R5F104AG, 
R5F104BA, R5F104BC, R5F104BD, R5F104BE, R5F104BF, R5F104BG, 
R5F104CA, R5F104CC, R5F104CD, R5F104CE, R5F104CF, R5F104CG, 
R5F104EA, R5F104EC, R5F104ED, R5F104EE, R5F104EF, R5F104EG, 
R5F104EH, R5F104FA, R5F104FC, R5F104FD, R5F104FE, R5F104FF, 
R5F104FG, R5F104FH, R5F104FJ, R5F104GA, R5F104GC, R5F104GD, 
R5F104GE, R5F104GF, R5F104GG, R5F104GH, R5F104GJ, R5F104GK, 
R5F104GL, R5F104JC, R5F104JD, R5F104JE, R5F104JF, R5F104JG, 
R5F104JH, R5F104JJ, R5F104LC, R5F104LD, R5F104LE, R5F104LF, 
R5F104LG, R5F104LH, R5F104LJ, R5F104LK, R5F104LL, R5F104MF, 
R5F104MG, R5F104MH, R5F104MJ, R5F104MK, R5F104ML, R5F104PF, 
R5F104PG, R5F104PH, R5F104PJ, R5F104PK, R5F104PL 

G1A 

R5F10E8A, R5F10E8C, R5F10E8D, R5F10E8E, R5F10EBA, R5F10EBC, 
R5F10EBD, R5F10EBE, R5F10EGA, R5F10EGC, R5F10EGD, R5F10EGE, 
R5F10ELC, R5F10ELD, R5F10ELE 

G1C R5F10JBC, R5F10JGC, R5F10KBC, R5F10KGC 
G1D R5F11AGG, R5F11AGH, R5F11AGJ 
G1E R5F10FLC, R5F10FLD, R5F10FLE, R5F10FMC, R5F10FMD, R5F10FME 



e² studio 6.3.0 Release Note 

R20UT4295EE0100  Rev.1.00  Page 6 of 51 
May 8th, 2018  

G1F 
R5F11B7C, R5F11B7E, R5F11BBC, R5F11BBE, R5F11BCC, R5F11BCE, 
R5F11BGC, R5F11BGE, R5F11BLC, R5F11BLE 

G1G R5F11EA8, R5F11EAA, R5F11EB8, R5F11EBA, R5F11EF8, R5F11EFA 
G1H R5F11FLJ, R5F11FLK, R5F11FLL 

H1D 
R5F11NGF, R5F11NGG, R5F11NLF, R5F11NLG, R5F11NME, R5F11NMF, 
R5F11NMG, R5F11PLF, R5F11PLG, R5F11RMG 

I1A R5F1076C, R5F107AC, R5F107AE, R5F107DE 
I1B R5F10MME, R5F10MMG, R5F10MPE, R5F10MPG 

I1C 
R5F10NLE, R5F10NLG, R5F10NME, R5F10NMG, R5F10NMJ, R5F10NPG, 
R5F10NPJ 

I1D 
R5F11768, R5F1176A, R5F11778, R5F1177A, R5F117A8, R5F117AA, 
R5F117AC, R5F117BA, R5F117BC, R5F117GA, R5F117GC 

I1E R5F11CBC, R5F11CCC 

L12 

R5F10RB8, R5F10RBA, R5F10RBC, R5F10RF8, R5F10RFA, R5F10RFC, 
R5F10RG8, R5F10RGA, R5F10RGC, R5F10RJ8, R5F10RJA, R5F10RJC, 
R5F10RLA, R5F10RLC 

L13 

R5F10WLA, R5F10WLC, R5F10WLD, R5F10WLE, R5F10WLF, 
R5F10WLG, R5F10WMA, R5F10WMC, R5F10WMD, R5F10WME, 
R5F10WMF, R5F10WMG 

L1A 
R5F11MMD, R5F11MME, R5F11MMF, R5F11MPE, R5F11MPF, 
R5F11MPG 

L1C 

R5F110ME, R5F110MF, R5F110MG, R5F110MH, R5F110MJ, R5F110NE, 
R5F110NF, R5F110NG, R5F110NH, R5F110NJ, R5F110PE, R5F110PF, 
R5F110PG, R5F110PH, R5F110PJ, R5F111ME, R5F111MF, R5F111MG, 
R5F111MH, R5F111MJ, R5F111NE, R5F111NF, R5F111NG, R5F111NH, 
R5F111NJ, R5F111PE, R5F111PF, R5F111PG, R5F111PH, R5F111PJ 

RX 

110 R5F51101, R5F51103, R5F51104, R5F51105, R5F5110H, R5F5110J 

111 
R5F51111, R5F51113, R5F51114, R5F51115, R5F51116, R5F51117, 
R5F51118, R5F5111J 

113 R5F51135, R5F51136, R5F51137, R5F51138 
130 R5F51303, R5F51305, R5F51306, R5F51307, R5F51308 

210 
R5F52103, R5F52104, R5F52105, R5F52106, R5F52107, R5F52108, 
R5F5210A, R5F5210B 

21A R5F521A6, R5F521A7, R5F521A8 
220 R5F52201, R5F52203, R5F52205, R5F52206 
230 R5F52305, R5F52306 
231 R5F52315, R5F52316, R5F52317, R5F52318 
23T R5F523T3, R5F523T5 
24T R5F524T8, R5F524TA, R5F524TB, R5F524TC, R5F524TE 
24U R5F524UB, R5F524UC, R5F524UE 
610 R5F56104, R5F56106, R5F56107, R5F56108 
621 R5F56216, R5F56217, R5F56218 
62G R5F562G7, R5F562GA 
62N R5F562N7, R5F562N8 
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62T R5F562T6, R5F562T7, R5F562TA 
630 R5F56307, R5F56308, R5F5630A, R5F5630B, R5F5630D, R5F5630E 

631 

R5F56316, R5F56317, R5F56318, R5F5631A, R5F5631B, R5F5631D, 
R5F5631E, R5F5631F, R5F5631G, R5F5631J, R5F5631K, R5F5631M, 
R5F5631MF, R5F5631N, R5F5631P, R5F5631PF, R5F5631W, R5F5631Y, 
R5S56310 

634 
R5F5634B, R5F5634B_5V, R5F5634D, R5F5634D_5V, R5F5634E, 
R5F5634E_5V 

63N 
R5F563NA, R5F563NB, R5F563ND, R5F563NE, R5F563NF, R5F563NK, 
R5F563NW, R5F563NY 

63T 
R5F563T4, R5F563T5, R5F563T6, R5F563TB, R5F563TB_5V, R5F563TC, 
R5F563TC_5V, R5F563TE, R5F563TE_5V 

64M R5F564MF, R5F564MG, R5F564MJ, R5F564ML 

651 
R5F56514, R5F56517, R5F56519, R5F5651C, R5F5651C_DUAL, 
R5F5651E, R5F5651E_DUAL 

65N 
R5F565N4, R5F565N7, R5F565N9, R5F565NC, R5F565NC_DUAL, 
R5F565NE, R5F565NE_DUAL 

71M R5F571MF, R5F571MG, R5F571MJ, R5F571ML 

RZ 

A1 

R7S721000, R7S721000_DualSPI, R7S721001, R7S721001_DualSPI, 
R7S721010, R7S721010_DualSPI, R7S721011, R7S721011_DualSPI, 
R7S721020, R7S721020_DualSPI, R7S721021, R7S721021_DualSPI, 
R7S721030, R7S721030_DualSPI, R7S721031, R7S721031_DualSPI, 
R7S721034, R7S721034_DualSPI 

T1 

R7S910001, R7S910002, R7S910006, R7S910007, R7S910011, 
R7S910013, R7S910015, R7S910015_M3, R7S910016, R7S910016_M3, 
R7S910017, R7S910017_M3, R7S910018, R7S910018_M3, R7S910025, 
R7S910026, R7S910027, R7S910028, R7S910035, R7S910036, 
R7S910101, R7S910102, R7S910106, R7S910107, R7S910111, 
R7S910113, R7S910115, R7S910115_M3, R7S910116, R7S910116_M3, 
R7S910117, R7S910117_M3, R7S910118, R7S910118_M3, R7S910125, 
R7S910126, R7S910127, R7S910128, R7S910135, R7S910136 

G1 R8A77420, R8A77430, R8A77440, R8A77450, R8A77470 

Renesas 
Synergy 

*1 

S124 
R7FS124762A01CLM, R7FS124763A01CFL, R7FS124763A01CFM, 
R7FS124772A01CLM, R7FS124773A01CFL, R7FS124773A01CFM, 
R7FS124773A01CNB, R7FS124773A01CNE, R7FS124773A01CNF 

S128 R7FS128782A01CLM, R7FS128783A01CFJ, R7FS128783A01CFL, 
R7FS128783A01CFM, R7FS128783A01CNE, R7FS128783A01CNG 

S3A1 
R7FS3A17C2A01CLK, R7FS3A17C3A01CFB, R7FS3A17C2A01CBJ, 
R7FS3A17C2A01CLJ, R7FS3A17C3A01CFM,  
R7FS3A17C3A01CFP, R7FS3A17C3A01CNB 

S3A3 
R7FS3A37A2A01CLK, R7FS3A37A3A01CFB, R7FS3A37A2A01CBJ, 
R7FS3A37A2A01CLJ, R7FS3A37A3A01CFP, R7FS3A37A3A01CFM,  
R7FS3A37A3A01CNB 

S3A6 
R7FS3A6782A01CLJ, R7FS3A6783A01CFL, R7FS3A6783A01CFM, 
R7FS3A6783A01CFP, R7FS3A6783A01CNB, R7FS3A6783A01CNE, 
R7FS3A6783A01CNF 
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S3A7 
R7FS3A77C2A01CLK, R7FS3A77C3A01CFB, R7FS3A77C2A01CBJ, 
R7FS3A77C3A01CFP, R7FS3A77C2A01CLJ, R7FS3A77C3A01CFM, 
R7FS3A77C2A01CNB, R7FS3A77C3A01CNB 

S5D5 R7FS5D57A2A01CLK, R7FS5D57A3A01CFB, R7FS5D57A3A01CFP, 
R7FS5D57C2A01CLK, R7FS5D57C3A01CFB, R7FS5D57C3A01CFP 

S5D9 

R7FS5D97C2A01CBG, R7FS5D97C3A01CFC, R7FS5D97C2A01CLK, 
R7FS5D97C3A01CFB, R7FS5D97C3A01CFP,  
R7FS5D97E2A01CBG, R7FS5D97E3A01CFC, R7FS5D97E2A01CLK, 
R7FS5D97E3A01CFB, R7FS5D97E3A01CFP 

S7G2 

R7FS7G27H2A01CBD, R7FS7G27G2A01CBD, R7FS7G27H2A01CBG, 
R7FS7G27G2A01CBG, R7FS7G27H2A01CFC, R7FS7G27H3A01CFC, 
R7FS7G27G2A01CFC, R7FS7G27G3A01CFC, R7FS7G27H2A01CLK, 
R7FS7G27G2A01CLK, R7FS7G27H3A01CFB, R7FS7G27G3A01CFB, 
R7FS7G27G3A01CFP 

 

Note: *1: The Synergy Software Package (SSP) can supply additional Renesas Synergy™ device support. 
Please check the release note for the SSP version you are using for additional device support. 
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2.2 Code Generator Support 
 

CPU Family Devices 

RL78 

D1A 

R5F10CGB, R5F10CGC, R5F10CGD, R5F10CLD, R5F10CMD, R5F10CME, 
R5F10DGC, R5F10DGD, R5F10DGE, R5F10DLD, R5F10DLE, R5F10DMD, 
R5F10DME, R5F10DMF, R5F10DMG, R5F10DMJ, R5F10DPE, R5F10DPF, 
R5F10DPG, R5F10DPJ, R5F10TPJ 

F12 

R5F10968, R5F1096A, R5F1096B, R5F1096C, R5F1096D, R5F1096E, 
R5F109AA, R5F109AB, R5F109AC, R5F109AD, R5F109AE, R5F109BA, 
R5F109BB, R5F109BC, R5F109BD, R5F109BE, R5F109GA, R5F109GB, 
R5F109GC, R5F109GD, R5F109GE, R5F109LA, R5F109LB, R5F109LC, 
R5F109LD, R5F109LE 

F13 

R5F10A6A, R5F10A6C, R5F10A6D, R5F10A6E, R5F10AAA, R5F10AAC, 
R5F10AAD, R5F10AAE, R5F10ABA, R5F10ABC, R5F10ABD, R5F10ABE, 
R5F10AGA, R5F10AGC, R5F10AGD, R5F10AGE, R5F10AGF, R5F10AGG, 
R5F10ALC, R5F10ALD, R5F10ALE, R5F10ALF, R5F10ALG, R5F10AME, 
R5F10AMF, R5F10AMG, R5F10BAC, R5F10BAD, R5F10BAE, R5F10BAF, 
R5F10BAG, R5F10BBC, R5F10BBD, R5F10BBE, R5F10BBF, R5F10BBG, 
R5F10BGC, R5F10BGD, R5F10BGE, R5F10BGF, R5F10BGG, R5F10BLC, 
R5F10BLD, R5F10BLE, R5F10BLF, R5F10BLG, R5F10BME, R5F10BMF, 
R5F10BMG 

F14 

R5F10PAD, R5F10PAE, R5F10PBD, R5F10PBE, R5F10PGD, R5F10PGE, 
R5F10PGF, R5F10PGG, R5F10PGH, R5F10PGJ, R5F10PLE, R5F10PLF, 
R5F10PLG, R5F10PLH, R5F10PLJ, R5F10PME, R5F10PMF, R5F10PMG, 
R5F10PMH, R5F10PMJ, R5F10PPE, R5F10PPF, R5F10PPG, R5F10PPH, 
R5F10PPJ 

F15 

R5F113GK, R5F113GL, R5F113LK, R5F113LL, R5F113MK, R5F113ML, 
R5F113PG, R5F113PH, R5F113PJ, R5F113PK, R5F113PL, R5F113TG, 
R5F113TH, R5F113TJ, R5F113TK, R5F113TL 

G10 R5F10Y14, R5F10Y16, R5F10Y17, R5F10Y44, R5F10Y46, R5F10Y47 
G11 R5F1051A, R5F1054A, R5F1056A, R5F1057A, R5F1058A 

G12 

R5F10266, R5F10267, R5F10268, R5F10269, R5F1026A, R5F10277, 
R5F10278, R5F10279, R5F1027A, R5F102A7, R5F102A8, R5F102A9, 
R5F102AA, R5F10366, R5F10367, R5F10368, R5F10369, R5F1036A, 
R5F10377, R5F10378, R5F10379, R5F1037A, R5F103A7, R5F103A8, 
R5F103A9, R5F103AA 
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G13 

R5F1006A, R5F1006C, R5F1006D, R5F1006E, R5F1007A, R5F1007C, 
R5F1007D, R5F1007E, R5F1008A, R5F1008C, R5F1008D, R5F1008E, 
R5F100AA, R5F100AC, R5F100AD, R5F100AE, R5F100AF, R5F100AG, 
R5F100BA, R5F100BC, R5F100BD, R5F100BE, R5F100BF, R5F100BG, 
R5F100CA, R5F100CC, R5F100CD, R5F100CE, R5F100CF, R5F100CG, 
R5F100EA, R5F100EC, R5F100ED, R5F100EE, R5F100EF, R5F100EG, 
R5F100EH, R5F100FA, R5F100FC, R5F100FD, R5F100FE, R5F100FF, 
R5F100FG, R5F100FH, R5F100FJ, R5F100FK, R5F100FL, R5F100GA, 
R5F100GC, R5F100GD, R5F100GE, R5F100GF, R5F100GG, R5F100GH, 
R5F100GJ, R5F100GK, R5F100GL, R5F100JC, R5F100JD, R5F100JE, 
R5F100JF, R5F100JG, R5F100JH, R5F100JJ, R5F100JK, R5F100JL, 
R5F100LC, R5F100LD, R5F100LE, R5F100LF, R5F100LG, R5F100LH, 
R5F100LJ, R5F100LK, R5F100LL, R5F100MF, R5F100MG, R5F100MH, 
R5F100MJ, R5F100MK, R5F100ML, R5F100PF, R5F100PG, R5F100PH, 
R5F100PJ, R5F100PK, R5F100PL, R5F100SH, R5F100SJ, R5F100SK, 
R5F100SL, R5F1016A, R5F1016C, R5F1016D, R5F1016E, R5F1017A, 
R5F1017C, R5F1017D, R5F1017E, R5F1018A, R5F1018C, R5F1018D, 
R5F1018E, R5F101AA, R5F101AC, R5F101AD, R5F101AE, R5F101AF, 
R5F101AG, R5F101BA, R5F101BC, R5F101BD, R5F101BE, R5F101BF, 
R5F101BG, R5F101CA, R5F101CC, R5F101CD, R5F101CE, R5F101CF, 
R5F101CG, R5F101EA, R5F101EC, R5F101ED, R5F101EE, R5F101EF, 
R5F101EG, R5F101EH, R5F101FA, R5F101FC, R5F101FD, R5F101FE, 
R5F101FF, R5F101FG, R5F101FH, R5F101FJ, R5F101FK, R5F101FL, 
R5F101GA, R5F101GC, R5F101GD, R5F101GE, R5F101GF, R5F101GG, 
R5F101GH, R5F101GJ, R5F101GK, R5F101GL, R5F101JC, R5F101JD, 
R5F101JE, R5F101JF, R5F101JG, R5F101JH, R5F101JJ, R5F101JK, 
R5F101JL, R5F101LC, R5F101LD, R5F101LE, R5F101LF, R5F101LG, 
R5F101LH, R5F101LJ, R5F101LK, R5F101LL, R5F101MF, R5F101MG, 
R5F101MH, R5F101MJ, R5F101MK, R5F101ML, R5F101PF, R5F101PG, 
R5F101PH, R5F101PJ, R5F101PK, R5F101PL, R5F101SH, R5F101SJ, 
R5F101SK, R5F101SL 

G14 

R5F104AA, R5F104AC, R5F104AD, R5F104AE, R5F104AF, R5F104AG, 
R5F104BA, R5F104BC, R5F104BD, R5F104BE, R5F104BF, R5F104BG, 
R5F104CA, R5F104CC, R5F104CD, R5F104CE, R5F104CF, R5F104CG, 
R5F104EA, R5F104EC, R5F104ED, R5F104EE, R5F104EF, R5F104EG, 
R5F104EH, R5F104FA, R5F104FC, R5F104FD, R5F104FE, R5F104FF, 
R5F104FG, R5F104FH, R5F104FJ, R5F104GA, R5F104GC, R5F104GD, 
R5F104GE, R5F104GF, R5F104GG, R5F104GH, R5F104GJ, R5F104GK, 
R5F104GL, R5F104JC, R5F104JD, R5F104JE, R5F104JF, R5F104JG, 
R5F104JH, R5F104JJ, R5F104LC, R5F104LD, R5F104LE, R5F104LF, 
R5F104LG, R5F104LH, R5F104LJ, R5F104LK, R5F104LL, R5F104MF, 
R5F104MG, R5F104MH, R5F104MJ, R5F104MK, R5F104ML, R5F104PF, 
R5F104PG, R5F104PH, R5F104PJ, R5F104PK, R5F104PL 

G1A 

R5F10E8A, R5F10E8C, R5F10E8D, R5F10E8E, R5F10EBA, R5F10EBC, 
R5F10EBD, R5F10EBE, R5F10EGA, R5F10EGC, R5F10EGD, R5F10EGE, 
R5F10ELC, R5F10ELD, R5F10ELE 

G1C R5F10JBC, R5F10JGC, R5F10KBC, R5F10KGC 
G1D R5F11AGG, R5F11AGH, R5F11AGJ 
G1E R5F10FLC, R5F10FLD, R5F10FLE, R5F10FMC, R5F10FMD, R5F10FME 
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G1F 
R5F11B7C, R5F11B7E, R5F11BBC, R5F11BBE, R5F11BCC, R5F11BCE, 
R5F11BGC, R5F11BGE, R5F11BLC, R5F11BLE 

G1G R5F11EA8, R5F11EAA, R5F11EB8, R5F11EBA, R5F11EF8, R5F11EFA 
G1H R5F11FLJ, R5F11FLK, R5F11FLL 

H1D 
R5F11NGF, R5F11NGG, R5F11NLF, R5F11NLG, R5F11NME, R5F11NMF, 
R5F11NMG, R5F11PLF, R5F11PLG, R5F11RMG 

I1A R5F1076C, R5F107AC, R5F107AE, R5F107DE 
I1B R5F10MME, R5F10MMG, R5F10MPE, R5F10MPG 
I1C R5F10NLE, R5F10NLG, R5F10NME, R5F10NMG, R5F10NMJ, R5F10NPJ 

I1D 
R5F11768, R5F1176A, R5F11778, R5F1177A, R5F117A8, R5F117AA, 
R5F117AC, R5F117BA, R5F117BC, R5F117GA, R5F117GC 

I1E R5F11CBC, R5F11CCC 

L12 

R5F10RB8, R5F10RBA, R5F10RBC, R5F10RF8, R5F10RFA, R5F10RFC, 
R5F10RG8, R5F10RGA, R5F10RGC, R5F10RJ8, R5F10RJA, R5F10RJC, 
R5F10RLA, R5F10RLC 

L13 

R5F10WLA, R5F10WLC, R5F10WLD, R5F10WLE, R5F10WLF, R5F10WLG, 
R5F10WMA, R5F10WMC, R5F10WMD, R5F10WME, R5F10WMF, 
R5F10WMG 

L1A 
R5F11MMD, R5F11MME, R5F11MMF, R5F11MPE, R5F11MPF, 
R5F11MPG 

L1C 

R5F110ME, R5F110MF, R5F110MG, R5F110MH, R5F110MJ, R5F110PE, 
R5F110PF, R5F110PG, R5F110PH, R5F110PJ, R5F111ME, R5F111MF, 
R5F111MG, R5F111MH, R5F111MJ, R5F111PE, R5F111PF, R5F111PG, 
R5F111PH, R5F111PJ 

RX 

110 R5F51101, R5F51103, R5F51104, R5F51105, R5F5110H, R5F5110J 

111 
R5F51111, R5F51113, R5F51114, R5F51115, R5F51116, R5F51117, 
R5F51118, R5F5111J 

113 R5F51135, R5F51136, R5F51137, R5F51138 
130 R5F51303, R5F51305 
230 R5F52305, R5F52306 
231 R5F52315, R5F52316, R5F52317, R5F52318 
23T R5F523T3, R5F523T5 
24T R5F524T8, R5F524TA, R5F524TB, R5F524TC, R5F524TE 
24U R5F524UB, R5F524UC, R5F524UE 
64M R5F564MF, R5F564MG, R5F564MJ, R5F564ML 
651 R5F56514, R5F56517, R5F56519 
65N R5F565N4, R5F565N7, R5F565N9 
71M R5F571MF, R5F571MG, R5F571MJ, R5F571ML 

RZ 

T1 

R7S910001, R7S910002, R7S910006, R7S910007, R7S910011, 
R7S910013, R7S910015, R7S910016, R7S910017, R7S910018, 
R7S910025, R7S910026, R7S910027, R7S910028, R7S910035, 
R7S910036, R7S910101, R7S910102, R7S910106, R7S910107, 
R7S910111, R7S910113, R7S910115, R7S910116, R7S910117, 
R7S910118, R7S910125, R7S910126, R7S910127, R7S910128, 
R7S910135, R7S910136 
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3. Smart Manual Support 
Smart manual support is delivered independently of e² studio releases when available. The following devices are 
available as of the 21st of May, 2018. 

• RX62G 

• RX62T 

• RX63N 

• RX63T 

• RX64M 

• RX71M 

• RX110 

• RX111 

• RX113 

• RX210 

• RX220 

• RX631 

• RX651 

• RX65N 

• RX24U 

• RX24T 

• RL78/L12 

• RL78/L13 

• RL78/G14 

• RL78/G13 

• RL78/G12 

• RL78/G11 

• RL78/G10 

• RL78/G1F 
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4. What is new in 6.3.0? 
Component Device Description 
GCC Plugins RL78, 

RX, 
Synergy, 
RZ 

When building source files in GCC toolchains the build plugins now 
correctly build source files when there is a mixture of upper and lower-
case file extensions; e.g. (“.s” and “.S”) and (“.c” and “.C”) 

Previously some files remained not built. 

 
GCC Plugins RL78, 

RX, 
Synergy, 
RZ 

When switching build artifact from application to library in the GCC 
build plugins the file extension is now correctly added. 

 
GCC Plugins RZ When importing a RZ project the import process has been improved. 

In e² studio 6.2.0 or earlier, there were problems on import which would 
cause subsequent build failures. 

This will now work correctly when importing projects with the GNU 
ARM-none toolchain or converting them to for GNU Tools for ARM 
Embedded (hereinafter GNU ARM Embedded) toolchain. 

 
Memory 
Usage  

RZ, 
Synergy 

In some cases when using the GNU ARM Embedded toolchains, the 
memory usage view could not read the linker map file. These cases 
have now been resolved. 

RZ Project 
Generation 

RZ In the new generated GNU ARM Embedded project, global 
variables were initialized with and without -fdata-sections option.  
 
For the existing GNU ARM Embedded projects, you may need to 
add an wildcard description *(.data.*) in the linker script. Please 
refer to the Open Issues of V6.2.0 at (link).  
https://www2.renesas.eu/_custom/software/ree_eclipse/e2studio6/d
ocs/releasenotes/6.2.0/openissues.htm 
 

  

https://www2.renesas.eu/_custom/software/ree_eclipse/e2studio6/docs/releasenotes/6.2.0/openissues.htm
https://www2.renesas.eu/_custom/software/ree_eclipse/e2studio6/docs/releasenotes/6.2.0/openissues.htm
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5. What is new in 6.2.0? 
Component Device Description 

Current 
Consumption 

RX Current consumption is now supported for the RX100 and RX200 
device series using the E2 emulator. 

This includes the integrated monitor point support in the e2 studio 
editor. 

 
GCC Build RL78, 

RX, 
Synergy, 
RZ 

When using GCC based toolchains if a project links external *.obj 
files, the linker was not be called even when these objects were 
modified. 

The makefile generation has been improved to include these files to 
ensure this will cause a link as expected. 

CCRL Build RL78 Support added for CC-RL V1.06.00 toolchain. 
 

CCRX Build RX Support added for CC-RX V2.08.00 toolchain. 
 

MISRA-C 
CCRL Build 

RL78 Some rule numbers of MISRA-C are added by CC-RL V1.06.00. 
 
When moving from CCRL v1.05 to v1.06, following MISRA-C 2012 
rule will be added: 

status for 
C90 

for both C90 
and C99 for C99 

status 
"Required"   18.7 8.14 ; 9.5 ; 9.4 ; 

13.1 ; 21.11; 

status 
"Advisory"     21.12 

status 
"Mandatory"     17.6 

 

CCRL and 
CCRX Build 

RL78, RX Environment variables of file paths were stored in long format from 6.0. 
This caused issues when spaces were resident in paths. 

From 6.2 onwards the paths will be stored in their short format to avoid 
this problem. 

CCRL Build RL78 When building the CC-RX and CC-RL toolchains handle the –library 
option differently. 

The CC-RX toolchain includes the standard library files within the 
LinkerSubCommand.tmp file. The CC-RL build plugin has been 
modified to match this specification. 

Code 
Generator 

RX, RL, 
RZ 

The code generator generates files in your project when setup. In 
some instances you may have modified these files with your code 
changes. If the code generator generates code when these files 
have unsaved changes it is possible to lose your code changes. 
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In 6.2 a warning will be shown giving you a chance to not lose your 
source code edits.  

Code 
Generator 

RZ 
The following enhancements have been made to the RZ/T1 code 
generator feature: 

1. You can now select the following signal in the ELC of the 
RZ/T1's code generator. 
 

• EtherMAC IEEE1588 SYNCOUT 

o All RZ/T1 products have this menu. 

• EtherCAT Sync0 and EtherCAT Sync1 

o The products that support EtherCAT have this 
menu.  

2. The Code Generator can generate the code of 
MPC.PxxPFS and PORTn.PMR for ENCIF08, ENCIF09, 
ENCIF10, ENCIF11 and ENCIF12 of RZ/T1. 

3. You can now specify a time value for the GPT on the RZ/T1 
code generator. In the past, you had to input a register 
value on the input box for "Compare match value" of the 
RZ/T1 code generator. This should improve usability. 

4. The code generator now supports the 32-bit Phase 
Counting Mode of RZ/T1's MTU3a. 

 
Code 

Generator 
RL78 

The code generator now has data flash library support for the 
following devices. 
 

• For RL78/G13 

o R5F1006E, R5F1007E, R5F1008E, R5F100AE, 
R5F100BE, R5F100CE, R5F100EE, R5F100FE, 
R5F100GE, R5F100JE, R5F100LE, 
R5F100FJ, R5F100GJ, R5F100JJ, R5F100LJ, 
R5F100MJ, R5F100PJ, 
R5F100FL, R5F100GL, R5F100JL, R5F100LL, 
R5F100ML, R5F100PL, R5F100SL 

• For RL78/F13 

o R5F10A6E, R5F10AAE, R5F10ABE, R5F10AGE, 
R5F10ALE, 
R5F10AGG, R5F10ALG, R5F10AMG,R5F10BAG, 
R5F10BBG, R5F10BGG,R5F10BLG, R5F10BMG 

• For RL78/F14 

o R5F10PGF, R5F10PLF, R5F10PMF, R5F10PGJ, 
R5F10PLJ, R5F10PMJ, 
R5F10PPJ 
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Consumption 
Current 

RX, RL78 Various improvements have been made to the current consumption 
view to remedy the problems below: 

• Current Consumption settings were not being saved correctly 
when terminating e2 studio while still connected to the 
debugger. 

• Zooming in or out of the Consumption Current view or 
dragging the scrollbar when the plugin is "Getting 
Consumption Current data..." could cause the view to hang 
and no data to be displayed. 

• When setting monitor points and opening the acquisition 
dialog, it was not possible to specify ‘between monitor 
points’. This is now enabled before measurement. When 
the address is not fixed the monitor point will have the 
source file and line number to identify its position.  

• It was not possible to remove multiple monitor points in one 
operation. 

• The recently used find information is now synchronized 
between the combo box on the view and the find dialog. 

RH850 
Debugging 

RH850 RH850 P1x-C is now supported.  

Specifically the following devices are added: 

• P1H-C 
o R7F701370AEEBG, R7F701371EABG, 

R7F701372EABG, R7F701396EABG 
• P1M-C 

o R7F701373xABG, R7F701374xAFP, 
R7F701397xABG 

• P1L-C 
o R7F701388, R7F701389, R7F701390, R7F701391 

Debug 
Configuration 

All When launching the debugger in e2 studio 6.2 the selected device 
in the debug configuration is now compared to that selected in the 
project. When these devices do not match it may cause problems 
and confusion when you are debugging. 
 
So in this case a warning message is now displayed informing you 
of this situation. You can then decide to cancel or proceed as 
normal. 
  

Linux 
Debugging  

RZ It is now possible to attach to an already running process on the target 
board and then start a debugging session for this process. This is 
available via the “Attach Only” check box on the “Main” tab of the 
Debug Configuration. 
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Linux 

Debugging  
RZ Files needed for debugging can now be transferred as part of the 

connection process. This can be done from the Debugger tab and 
specifically the “Downloads” sub-tab. 

The user interface allows you to specify the file, the path on the host 
machine and the path to copy to on the target. 

 

 

 
RL78 

Debugging 
RL78 

New device groups have been added to e2 studio: 

・RL78/G11(10pin/16pin) 

Updated group: 
・RL78/I1C: 

 The following IO register has been moved from the SYSTEM 
module to OTHER module: 
MULBL[FFF3Ch] / MULBH[FFF3Eh] /  
MUL32UL[F0280h] / MUL32UH[F0282h] / MUL32SL[F0284h] / 
MUL32SH[F0286h] / MAC32UL[F0288h] / MAC32UH[F028Ah] / 
MAC32SL[F028Ch] / MAC32SH[F028Eh] / MULR0[F0290h] / 
MULR1[F0292h] / MULR2[F0294h] / MULR3[F0296h] / 
MULC[F029Ah] / MULST[F029Ah] / MACSF[F029Ah] / 
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MACOF[F029Ah] / MULFRAC[F029Ah] / MULSM[F029Ah] / 
MACMODE[F029Ah] 

・RL78/G1D: 

 The following IO register has been added: 
P8[FFF08h] / P10[FFF0Ah] / P11[FFF0Bh] / P15[FFF0Fh] / 
PM8[FFF28h] / PM10[FFF2Ah] / PM11[FFF2Bh] / PM15[FFF2Fh] 

  
 The following IO register has been removed: 

KRM[FFF37h] / MULA[FFFF0h] / MULB[FFFF2h] / 
MUL0H[FFFh4] /  
MUL0L[FFFF6h] / TEMPCAL0[F00ACh] / TEMPCAL1[F00ADh] /  
TEMPCAL2[F00AEh] / TEMPCAL3[F00AFh] / RMC[F00F4h] /  
PAENB[F00F4h] / WDVOL[F00F4h] 

  
 The following IO register name has been changed: 

FRA2H -> DRA2H [F0203h] 

・RL78/G11 

 The following IO register has been bit information added: 
TMR.TKBTRG0[F0412] 

・RL78/G10 

 The version number has been updated. There are no other 
changes. 
E1.03a -> V1.03 

 
RX 

Debugging 
RX The IO register related files have been updated for RX651 and RX65N. 

Image view All The Raw Image rendering feature now supports new image 
formats: 

The view now also supports the Y10, Y12, Y14, Y16, Y12-UV8 
image formats. 

Y10, Y12, Y14, Y16 image formats has been added into the 
Monochrome format group: 
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Y12-UV8 semi-planar image format has been added into the YCbCr 
format group: 

 

 
Linker Script 

Editor 
All The Linker script editor for GCC has been enhanced to include a visual 

representation of the linker script. 

This should allow easier manipulation and editing of the script file. It is 
available from the “Graphical Editor” tab when opening an “.ld” file in 
the e2 studio environment. 

Clicking the “Arrow icons” expands and collapses the graphical 
interface to show section details. 

 

 
Memory 
Usage 

RX, RL When using the CC-RX v2.07 or CC-RL v1.05 the memory usage view 
has been enhanced to show the attribute field where available. See 
below: 
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In addition when the toolchain is using the “Output the relocation 
attribute” the map file can still be shown correctly. This was not working 
correctly in 6.1 or earlier. 

 
MISRA-C 
CCRL and 

CCRX 

RL, RX In versions before 6.2 the MISRA-C rule check is only executed when 
the file is opened. The rule check is now also executed when the file is 
modified internally or externally to e2 studio.  

RZ Project 
Generation 

RZ The RZ/T1 project generator now disables the interworking option for 
Cortex-M devices such as for RZ/T1 R-IN (Cortex-M3). 

Smart Demo Synergy When Renesas Synergy device support is installed in your e2 studio 
and you access the tools for the first time you will be prompted to view 
a demonstration. Currently there are 2 supported demonstrations, one 
for creating a Synergy project and another for setting up a very simple 
software stack. 

Note: This feature is only supported on English language operating 
systems. 

The notification is shown in the bottom right hand corner of the IDE. 
See below: 

 

If you then click the notification message it opens an Eclipse cheat 
sheet with access to the related demonstration software. See below: 
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Pressing “Click to Begin” will then start the demonstration. This then 
shows the steps and actually performs them in your workspace. 

Note: The perspective change dialogs are not automated so if this 
appears you must click OK to proceed. 

 
Synergy 

Clock Page 
 

Synergy The clock routing lines on the Synergy Configuration Editor – Clocks 
page have been improved to make them clearer and less ambiguous. 
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Synergy 
Configuration 

Editor 

Synergy When components are removed from a Synergy project the source 
files and directories are now both removed correctly. 

Smart 
Application 

Note 

All The pop-up for the Smart Application Note can now support hyperlinks. 

Smart 
Browser 

Synergy The Smart Browser can now support the import of Synergy projects 
which are on the Renesas website. 

 

Synergy projects on the website often have more than one project to 
choose from in the archive. 

In this situation the following dialog is displayed to choose the one you 
want to import:

 
Smart 

Configurator 
RX Smart Configurator has been updated to support RX230/231 and 

RX71M. 
 
Support has also been added for the GCC toolchain as well as CC-
RX. 
 

Synergy 
Configuration 

Editor 

Synergy The Synergy Summary page has been updated for a better look 
and feel. 
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Synergy 
Configuration 

Editor 

Synergy The SSP user manual can now be linked when installed using the 
Synergy platform installer. It can be viewed by pressing the 
following button: 
 

 
Synergy 

Configuration 
Editor 

Synergy When using SSP 1.2 or greater the ICU tab will be now be hidden 
from view. 
 
Interrupts are edited via the properties window. 

Synergy 
Project 

Generator 

Synergy It is now possible to create your Synergy project as a static library. 
 
This is possible via the “Synergy C/C++ Project” menu item. 
 

 
 
Once selected the following dialog is displayed allowing the 
selection between C, C++ and executable or library. 
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6. What is new in 6.1.0? 
Component Device Description 

RZ/G 
Debugging 

RZ/G When installing the RZ/G feature the Trace Compass and Lttng plugins 
are now also installed. 

This will enable Linux OS trace support when debugging Linux target. 
RZ/G 

Toolchain 
integration 

RZ/G Linaro GCC version 5.2 is now supported for RZ/G. 

Stack 
Analysis 

All Support within the Stack Analysis plugin has been added for GCC 
toolchains. 

DS-5 
Converter 

RZ Support for the ARM DS-5 project converter has been added back into 
the product. It is available in the standard Import Eclipse system and 
can be accessed from “File->Import…” 

 

This importer will migrate the toolchain to the Launchpad GNU ARM 
toolchain. This can be downloaded from here. 

This feature can import from the following IDE/toolchain combinations: 

• ARM DS-5 project with a KPIT RZ GCC Toolchain. 
• ARM DS-5 project with a KPIT ARM-None GCC Toolchain. 

The project once converted may not build and operate perfectly for a 
list of known issues with the conversion please see the latest open 
issue list here: 

 

 

https://launchpad.net/gcc-arm-embedded
https://www2.renesas.eu/_custom/software/ree_eclipse/e2studio6/docs/releasenotes/6.1.0/openissues.htm
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CCRX to RX 
GCC Project 

Converter 

RX Support for the CC-RX to GCC project converter has been added back 
into the product. It is available in the standard Import Eclipse system 
and can be accessed from “File->Import…” 
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There is no guarantee that the project once converted will build and 
operate perfectly. For a list of known issues with the conversion please 
see the latest open issue list here: 

 
MISRA-C 
Settings 

RX, RL The MISRA-C plugin settings have been moved from the workspace 
location to the project location. 

This enables the settings to be shared among users of the same 
project. 

Visual 
Expressions 

All The Visual Expressions plugin settings have been moved from the 
workspace location to the project location. 

This enables the settings to be shared among users of the same 
project. 

Memory 
Usage 

RZ The memory usage view has been enhanced to support GNU ARM 
Embedded toolchain. 

  

https://www2.renesas.eu/_custom/software/ree_eclipse/e2studio6/docs/releasenotes/6.1.0/openissues.htm
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7. What is new in 6.0.0? 
Note: This section is reserved for the new users migrated to 6.0/6.1 from 5.x or earlier versions of e2 studio. 

Component Device Description 
Project 

Generation 
All The project generation tools in 6.0 have been revised and the look and 

feel improved. 

The new generator is accessed via the C/C++ Project. 

 

The RZ/G project generator is accessed from the RZ/G C/C++ Project 
menu item in the same manner as 5.x. 

The Synergy project generators are accessed from Synergy C Project 
or Synergy C++ Project in the same manner as 5.x. 

When selecting the C/C++ Project wizard the following dialog is shown 
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Note the C Managed Build and C++ Managed Build types are default 
CDT projects. Please use the Renesas project types for the device you 
wish to use. There are separate entries for each device, toolchain and 
project type (Executable or Library) combination. 

The actual wizard to create the projects also has an updated look and 
feel. The functionality provided is very similar to 5.x. 

 

When the project is created all generated files are stored within the 
project in the “generate” folder. This is to make it clearer which files 
within the project were provided by the project generator. 
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Revised 
Builder 

components 

 The builder components within e2 studio 6.0 have been overhauled and 
updated to work well with the latest CDT. 

The affected toolchains are CC-RX, CC-RL, GCC RX and GCC RL. 
For information on migration of old projects please see the useful 
information and workarounds section. 

In addition the GCC ARM toolchain being used for RZ development 
has been migrated to now use the gnuarmeclipse open source plugins 
that are already in use for Synergy projects. 

The new settings dialog are available from the C/C++ Build, Settings 
page within the project properties. See below:  

 

The look and feel for each toolchain is similar to before but there are 
some considerations worth noting: 

1. The Toolchain tab 
• This tab controls the selected toolchain and version. 

The “Change toolchain version” functionality present 
previous e2 studio versions has been removed and 
replaced with this. 

• In addition extra tools such as “Objcpy” or “Libgen” can 
be enabled on this tab. When enabling the checkbox 
for the tools they will only then appear in the builder 
settings. 
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2. The Device tab 
• Previous versions of e2 studio had a special 

preference page for the currently selected device. This 
has been removed and an additional tab named 
“Device” has been added to the build settings. 

• Here it is possible to change the device, re-generate 
project generation files and update the build settings 
accordingly. 

 

3. Linker section changes 

• For CCRX and CCRL the linker sections are 
represented as a single string. The section editor 
is not shown on the settings page. To access the 
graphical section editor press the “…” button. 

• For all GCC tools there is no longer a graphical 
section editor integrated into the settings user 
interface for the GCC build plugins. 



e² studio 6.3.0 Release Note 

R20UT4295EE0100  Rev.1.00  Page 32 of 51 
May 8th, 2018  

• Instead it uses the .ld linker script directly. A 
special graphical editor of .ld files has been 
integrated within the e2 studio. Simply double click 
the .ld file in the project and you can again edit the 
sections graphically. 

 

4. Renesas Quick Settings menu item 
• In previous versions of e2 studio there has been a 

menu named “Renesas Quick Settings”. 
• This menu item used to take you directly to the build 

settings for the selected project. 
• This functionality cannot be implemented in e2 studio 

6.0 so the menu item has been removed. 

Installer 
 

All The e2 studio product structure has been enhanced so that each 
device can be installed in its own independent way. 

Each device’s support is versioned independently from the main 6.0 
product. It means that updates to one device will not affect the other 
devices. 

The installer allows you to select this at installation time. 
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The above example shows a user only installing the Renesas Synergy 
device family. Subsequent updates of other device families will not 
affect this installation unless the main core of the product is also 
updated. 

To see the version of your installed device feature you can visit the 
About Box. 

 

Clicking on the device will give the installed versions of components for 
this device. e.g. In the example below RX was clicked: 
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This version information will be valuable if you need to discuss 
problems you encounter with Renesas technical support contacts. 

 
Updated user 

interface 
All Some changes have been made to the e2 studio 6.0 user interface to 

improve the usability of the user interface. 

The most major improvement is the introduction of the Launch Bar. 

 

This launch bar allows you to very clearly understand what will happen 
when the build and debug buttons are pressed. The selected project 
and debug configuration in the drop list will provide the context for the 
operation. 

In addition the debug toolbar buttons have been switched off from the 
debug view and added to the main debug toolbar. 

 
RZ Semi 
hosting 

RZ When using the RZ debugger in previous e2 studio semi hosting was 
supported but did not fully support the SYS mode. This mode of 
operation is now supported in the e2 studio 6.0 RZ debugger when 
using the Segger J-link emulator. 
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Smart 
Browser 

 

All The Smart Browser has been enhanced to show when updates are 
available for items shown within the user interface. 

 

When items such as updates to documents or new tool news 
information are available a notification bubble will be displayed 
informing you that new items are available. 

 

 
RTOS 

Graphical 
Stack Usage 

 

Synergy Stack usage is now shown in a graphical way when using the Partner 
OS plugin and ThreadX. 

 

 
XML 

Comparison 
Synergy 
and RX, 

RZ 

e2 studio now has a XML file comparison tool built into the UI. This can 
be used for the configuration.xml files in the Synergy Configuration 
Editor and the Smart Configurator. 

Right click on the file in the project tree that needs comparison and 
select “Compare With->Local History…” 
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The following dialog is then displayed: 

 

These are the list of revisions of the file that was selected in the project 
tree. Double clicking an instance of the file will then compare with the 
current version on disk. A difference window is shown showing the 
differences: 
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Help System 

 
All The help system in previous versions of e2 studio was not well 

organised which meant finding topics was not easy. 

In e2 studio 6.0 the help has been re-structured to make it easier to find 
what you are looking for. See below: 

 

 
Smart 

Configurator 
RX, RZ The main feature improvements for Smart Configurator in e2 studio 6.0 

include: 

• Code Generator driver support for RX64M [37 components] 
• CG driver support for RX65N/1 (+2MB devices) [37 

components] 
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• CG driver support for RX130  (+512KB devices) [35 
components] 

E2 Emulator RL78 E2 emulator support has been added to e2 studio 6.0. This emulator 
offers all the same functions as the E1 emulator. 

It also offers: 

• Consumption current measurement support. 
• External trigger support. 

The Consumption current measurement shows graphically the 
current drawn by the board. 

It allows monitor points to be set which are shown on this view as 
markers. This allows you to tie the source code to specific power 
consumption. 

 

 
Application All e2 studio has many debug views and not all are supported for all 

device families. 

This can cause confusion so a new feature has been added to close 
debug views that are not supported by the current debug session. 

This is available from the Window menu under the Perspective menu. 
Selecting the device will close all windows not supported by that 
device.  

Note this menu item is only available in the debug perspective. 
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Enhanced 
Threads 

Page 

Synergy The Synergy threads page has had the following enhancements made 
to it: 

• Keyboard navigation within the module stack viewer 
• Renaming threads will refactor code accordingly 
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8. Useful workarounds and information for 6.3.0 
Please visit the Renesas FAQ for e² studio for the latest up to date information: 

Online FAQ link. 

ID Component Workaround or information 
 Application This version of e² studio is based on Eclipse Neon.1 and CDT 9.2.1.  This 

release note does not describe the Eclipse framework and CDT plugin issues 
and fixes. You can find the detailed information on the sites below: 
 
For information on the Neon release see here: 
https://projects.eclipse.org/releases/neon 
 
CDT: 
Has been significantly improved and this version contains a major version up 
over 5.4: 
Please see New and Noteworthy for CDT here: 
 
https://wiki.eclipse.org/CDT/User/NewIn90 
https://wiki.eclipse.org/CDT/User/NewIn91 
https://wiki.eclipse.org/CDT/User/NewIn92 
 
The Eclipse bug tracker is here: 
https://bugs.eclipse.org/bugs/ 
 

 SH support The Renesas SH device family is no longer supported in e2 studio. 
 
If you need to use the SH device support please use e2 studio 5.4 or earlier. 
 

 Importing old 
projects into 
6.x 

All projects being migrated into e2 studio 6.0 from previous e2 studio versions will 
need to be migrated to the new builder plugins. The new builder plugins have 
different user interface pages and different option IDs. 
 
Upon opening an older workspace the following dialog would be displayed: 
 

 
 
Clicking OK will update the workspace to e2 studio 6.0. 
 
Importing an existing project to the workspace or opening a workspace with old 
projects will automatically start the legacy project upgrade procedure.  
 
If for some reason this process does not start it is also possible to launch the 
“Upgrade Legacy of e2 studio Projects…” from the project context menu. 
 

https://en-eu.knowledgebase.renesas.com/Special:Search?q=e2%20studio&path=&limit=55&page=2&tags=
https://projects.eclipse.org/releases/neon
https://wiki.eclipse.org/CDT/User/NewIn90
https://wiki.eclipse.org/CDT/User/NewIn91
https://wiki.eclipse.org/CDT/User/NewIn92
https://bugs.eclipse.org/bugs/
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The automatic system pops up a message bubble in the bottom left of the e2 
studio application window. 
 

 
 
After selecting the menu item or clicking the bubble the following dialog will be 
shown: 
 



e² studio 6.3.0 Release Note 

R20UT4295EE0100  Rev.1.00  Page 42 of 51 
May 8th, 2018  

  

 
 
To upgrade the project, click the corresponding check box and then click Finish. 
Note, this will update the project to the latest build plugins and options. Before 
doing this you should ensure your project is backed up as this operation is not 
reversible. 
 
It is possible to upgrade multiple projects in a single operation. 
 
For the GCC toolchains for RX ,RL and GNUARM-NONE have been made to 
the build options which mean we cannot guarantee the same binary output after 
upgrade. Please consider this before upgrading to 6.0. 
 
Another consideration for migration is that debug configurations when opened in 
6.0 will also need to be migrated. The following message will be displayed. 
 

 
 
Please ensure that your projects are backed up or in revision control before 
migration allowing you to return to older versions if required. 
 



e² studio 6.3.0 Release Note 

R20UT4295EE0100  Rev.1.00  Page 43 of 51 
May 8th, 2018  

 
 

Toolchain 
Management 
 

Before e2 studio 6.0 the toolchain management facility automatically upgraded or 
downgraded the imported project to the latest tools installed on the host 
machine. 
 
This no longer happens in e2 studio 6.0. Instead the toolchain remains the same 
and user operation is the only way to change the toolchain version. 
 
This operation is now available within the build settings on the toolchain tab. An 
example of CCRX is shown below: 
 

 
 
If the particular toolchain version does not exist and build is performed then an 
error message is displayed and the build will fail. 
 

 RZ Toolchain The now legacy KPIT GNU ARM-NONE toolchain is still supported within the e2 
studio product but now using the gnuarmeclipse plugins. 
 
In addition RZ within e2 studio now supports the GNU ARM Launchpad 
toolchain. Available from https://launchpad.net/gcc-arm-embedded. 
 
One drawback of this toolchain is that it does not have a standard library builder 
provided in the same manner as the legacy KPIT ARM-NONE toolchain. To use 
this feature for ARM Launchpad and gain access to the more efficient optlib 
libraries a further download is required. 
 
This can be downloaded within the e2 studio installer or directly from here: 
https://gcc-renesas.com/rz/rz-download-toolchains/ 
 
Once integrated it is possible to integrate the library generator from the toolchain 
tab of the build settings page. 
 

https://launchpad.net/gcc-arm-embedded
https://gcc-renesas.com/rz/rz-download-toolchains/
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See “Create Library generator” option. Once checked the library generator 
(libgen) is added to the available tool settings. 
 

 QE 
compatibility 

If QE for TCP/IP V1.0.0 is used, please update it to V1.0.1. 
Other QE series can be used with e2 studio 6.0. 
 
What is QE? 
https://www.renesas.com/products/software-tools/tools/solution-toolkit/qe.html 
 
Details of QE for TCP/IP 
https://www.renesas.com/products/software-tools/tools/solution-toolkit/qe-qe-for-
tcp-ip.html  
 

5954 Application If you experience the error message “org.eclipse.swt.SWTError: No more 
handles” this can be caused by certain multi-monitor software and the Eclipse 
framework. 
 
If this error occurs there are 2 workarounds: 
 

1. Use a single monitor display. 
2. Uninstall the multiple monitor software from your graphics chipset 

vendor and revert to the standard Windows multi-monitor feature. 
 

6981 RL78 
Debugging 

When debugging IAR C source file with an OCD emulator (E1), the Monitor 
program area (0x00002-0x00003) is used. 
 
So this area must be excluded from usable address space. Please add '-HFF' in 
the linker option. 
 
- Open Property. 
 
- Select [C/C++ build]-[Settings] at left side. 
 
- Select 'IAR RL78 Xlink linker' at right side, add '-HFF' at the textbox 'command'. 
 
Not doing this will cause problems with connection and download when using 
interrupts. 
 

NA Application If you are experiencing slow building of projects within e² studio there are some 
possibilities to improve. 

https://www.renesas.com/products/software-tools/tools/solution-toolkit/qe.html
https://www.renesas.com/products/software-tools/tools/solution-toolkit/qe-qe-for-tcp-ip.html
https://www.renesas.com/products/software-tools/tools/solution-toolkit/qe-qe-for-tcp-ip.html
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The system environment will attempt to find the make.exe tool via the system 
environment.  If you ensure the directory make resides in is at the start of the 
path variable it will find it more quickly.  Especially important if there are network 
drives in the path. 
 
In the project properties, C/C++ Build tab, behavior tab you can switch on 
parallel build.  This will take advantage of the multi-cores on your host machine if 
it has them. 
 

NA RZ GCC In 3.0 the KPIT GCC RZ toolchain was supported at version 14.01.  This version 
is no longer supported within e² studio. 
 
KPIT modified the name of their ARM toolchain to be ARM-none-eabi to follow 
standard ARM naming convention like other GCC toolchain vendors. 
 
The ARM-none toolchain is available at versions 14.01, 14.02 and 16.01 from 
the www.gcc-renesas.com website.  The binaries in the 14.01 version are 
identical to those used in the 14.01 RZ toolchain. 
 
Once the toolchain is installed your projects will be imported and ported to 
ensure there is as little disruption as possible due to this change. 
 

NA KPIT GCC The KPIT toolchains are now no longer supported by the www.kpitgnutools.com 
website. Support is now available from the www.gcc-renesas.com website. 
 
In addition, there are two new releases for the GNU toolchains for RX and RL78. 
These are now named Renesas GCC for RX and Renesas GCC for RL78. 
 
Both integrate into e² studio and can be selected from the project wizard. 
 

2010 HEW 
Importer 

Symptoms: Project fails to build after importing a legacy project from HEW 
 
Conditions: If a long filename or path is used, and the HEW project importer is 
used, the project may fail to build. 
 
Workaround: Move the original HEW project to a shallow directory structure (i.e.) 
C:\Workspace and import from there.  Also, ensure that the HEW project is 
relocated before importing into e² studio. 
 

1922 Application Symptoms: Project fails to build in first instance after archive project import (not 
from HEW) 
 
Conditions: If an archived project is imported, it may fail to build the first time, 
due to a residual .d file. 
 
Workaround: Clean and Build a second time. 
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2762 CODAN When using assembly code within a C source file, CODAN errors can be 
observed in the editor. Even though the project builds successfully, or even after 
rebuild index. 
 
Indexer buffer can be insufficient to process whole project. 
Please try giving larger values for the following configurations. 
 
Open preferences dialog through “Window”->”Preferences” menu. In “C/C++” -> 
“Indexer” tree, you will indexer configuration as shown below: 

 
 
Put larger values for each red-framed variables, then rebuild project or rebuild 
index.  

2728 GDB Step into does not always work when using the CC-RX 1.02.01 toolchain. 
 
To ensure this behaves correctly you will need to use CC-RX 2.00.00 or greater 
as this issue with the debug information is corrected in this release. 
 

NA Eventpoints If eventpoints do not always work just after they are set, you can use the "Apply 
to Target" toolbar button in the Eventpoint view to send the Eventpoints to the 
target manually.  This will always ensure the debugger target has all the required 
eventpoint updates before execution starts. 
 

5772 IAR Plugins The IAR Plugin Manager is included in e² studio and provides support for RX, 
RL78, RH850 and RZ (ARM). 
 
This tool, simplifies installation and configuration of IAR toolchain plugins. You 
can access this though Help -> IAR Embedded Workbench plugin manager. 
 

5903 Code 
Generator 

For the following RL78 code generator project, "Peripheral Functions" view tabs 
may not be operated with double-clicking "Peripheral Functions" branch of 
Project Explorer view. 
 
After creating/loading the project, please show "Code Preview" view by double-
clicking of "Code preview" branch at Project Explorer tree at first. Then, please 
access Code Generator setting tabs by double-clicking Project Explorer tree or 
using pull-down menu by pressing triangle button at the up-right corner of 
Peripheral Functions view. 
 
RL78/G12, RL78/G13, RL78/G14, RL78/G1A, RL78/I1A, RL78/F13, RL78/F14, 
RL78/F12, RL78/L12 
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6184 RL78/CC-RL 
debugging 

When the load module for RL78/G10 which created at CC-RL is debugged in E1, 
please specify the following option: 

[Linker] -> [Device] -> "Set enable/disable on-chip debug by link option 

7217 Application The restore default settings does not restore all of the options set during project 
generation.  Instead, it sets the defaults to the base settings for the device family 
in use. 

7524 RZ/T1 
Debugging 

In a RZ/T1 RAM-based project, the "Reload" function does not work. 

Reloading or re-downloading during debugging resets the device and the RAM 
content is erased. 

To continue the debugging, disconnect and connect the debugger again. 

 Use spaces 
as tabs 

Eclipse and CDT both have settings for use spaces as tabs. The option on the 
Editor preferences page conflicts with the CDT formatter settings. 

To change the use spaces as tabs option in e² studio please use this page: 

 
 Installer 

problems 
In some situations, the AVG virus checker appears to interfere with the e² studio 
installation process. If you experience such a problem, please temporarily 
disable the AVG tool and try the installation again. 

 Antivirus In some situations, the Norton anti-virus tool can interfere with the building of 
Renesas Synergy projects. If possible, please disable the antivirus program 
when building Renesas Synergy projects on systems with Norton Antivirus 
installed. 

 Green Hills 
RH850 
Projects 

When debugging the RH850 object built with the Green Hills compiler in e2 
studio, specify the following option for the compiler option. 

 -gtws 

The GUI setting menu is as follows. 

[GHS C Compiler for V800 Standalone]-[Debugging Option] 

     "Generate Target-Walkable Stack" -> On 

If this option is not specified, Step Over and Step Return may not work properly. 

17052 Debugging When debugging using a project with duplicate filenames that are located in 
different source folders problems can be seen with breakpoint setting. 

When a breakpoint is set at a source line in this file it will also stop at the same 
source line in the other same named file when execution passes through. 

18505 RZ 
debugging 

When debugging with RZ/T1 in certain situations you may experience problems 
stepping: 
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If the following conditions are met: 

  
1. Code is located close to address 0x0  
2. There is very little library code included into the project  
3. There are unused functions in the program  

The possibility arises that the code cannot be debugged. This due to --gc-
sections linker option which removes the unused functions but not the 
related debug information. 

There are several solutions to this problem:  
a. disable --gc-sections until those functions are used  
b. remove the unused functions 

 RZ GCC 
Build 

In 6.2 the RZ import functionality has been improved. However there is still 
possibilities of older projects causing problems when imported into e2 studio 
6.2. 

In older versions of the RZ build plugins the FPU option was not being 
handled correctly. When setting the “Soft” Floating point ABI the command 
line was still receiving –mfpu=vfpv3 incorrectly. This can now cause 
problems with older start-up code in older RZ projects. 

After import if you see an error relating to this please add –mfpu=vfpv3 to the 
“Other Assembler Flags” page of the Assembler tool. 

 RZ DS-5 
Project 
Import 

When a DS-5 project is imported into e2 studio the environment variables for 
Path and TCInstall are copied from the DS-5 environment.  
 
This is not correct. The way to correct this problem is to delete both of these 
paths and replace them with correct values to your toolchain. If you are 
unsure how to correct this please create a new project and copy the values 
from this to the converted project.  

 RX & RL78 
GCC Project 
Import 

When importing a KPIT RL78/RX Library C/C++ project from e2 studio 5.4 or 
before the build artifact settings are not correct. 
 
The output prefix should be set to “lib” but is in fact empty. 
 

 RZ/G debug In the case of debugging Linux application for RZ/G, the following error 
messages are shown in GDB server console when pushing [Step in] button 
or [Step Over] button. 
These messages can be ignored because the Step debugging should work 
properly even with these messages. 
 
Examples of error messages: 
 PassthroughTargetCommunication::sendResponse error 42 46 
 PassthroughTargetCommunication::sendResponse error 10 15 
 PassthroughTargetCommunication::sendResponse error 42 46 
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9. Open Issues in 6.3.0 
 
Open issues in the e2 studio 6.3 product will be kept up to date here: 
 
Please visit to see the latest open issue list. 
  

https://www2.renesas.eu/_custom/software/ree_eclipse/e2studio6/docs/releasenotes/6.3.0/openissues.htm
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10. Appendix 
10.1 Website and Support  
Renesas Electronics Website 

http://www.renesas.com/ 
 
Inquiries 

http://www.renesas.com/contact/ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.renesas.com/
http://www.renesas.com/contact/
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Notice
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for

the incorporation or any other use of the circuits, software, and information in the design of your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by

you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or other intellectual property rights of third parties, by or

arising from the use of Renesas Electronics products or technical information described in this document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application

examples.

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others.

4. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any and all liability for any losses or damages incurred by

you or third parties arising from such alteration, modification, copying or reverse engineering.

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for each Renesas Electronics product depends on the

product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic

equipment; industrial robots; etc.

"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products are

not intended or authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause

serious property damage (space system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims any and all

liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is inconsistent with any Renesas Electronics data sheet, user’s manual or

other Renesas Electronics document.

6. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for Handling and Using Semiconductor Devices” in the

reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation

characteristics, installation, etc. Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such specified

ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific characteristics, such as the occurrence of failure at a

certain rate and malfunctions under certain use conditions. Unless designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas

Electronics document, Renesas Electronics products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury, injury

or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety design for hardware and software, including but not limited to

redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult

and impractical, you are responsible for evaluating the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. You are responsible for carefully and

sufficiently investigating applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics

products in compliance with all these applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance with applicable

laws and regulations.

9. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws

or regulations. You shall comply with any applicable export control laws and regulations promulgated and administered by the governments of any countries asserting jurisdiction over the parties or

transactions.

10. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or transfers the product to a third party, to notify such third

party in advance of the contents and conditions set forth in this document.

11. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.
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